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INTRODUCTION

Purpose
This reference guide was designed for California State employees who work with documents in Portable Document Format (PDF) that must abide by: 
· California Government Code 11135 (d) (1-3) that adopted the Federal Rehabilitation Act Section 508,

· The State Administrative Manual (SAM) Chapter 4800, Section 4833 - Information Technology Accessibility Policy
· California’s Website Accessibility Standards – written by Information Organization, Usability, Currency, and Accessibility working group (IOUCA).
Objectives

This guide was created to assist California State employees with the basics and an understanding of Section 508 compliancy and making PDFs accessible.  By the end of this guide readers should:

· Know the difference between working with an original PDF document and a converted document. 

· Understand the importance in creating PDF documents from various output sources, e.g., Word, Excel, WordPerfect.

· Familiarize and apply accessibility tools to a PDF document.

· Tag table and form elements in a PDF document. 

· Comprehend how screen readers interpret tagged PDF files.

· Examine various testing methods for checking documents for accessibility. 

· Learn the Optical Character Recognition (OCR) process techniques.

Section 508 compliance
Section 508 compliance or “accessibility” enables individuals with disabilities – such as people with blindness, low vision, or mobility impairments – to read, hear and interact with computer-based information and content with or without the aid of assistive technology. A document is considered accessible if its content can be accessed by anyone, not just by people who can see well and use a mouse.
Accessibility is everywhere

We are constantly seeing changes in our daily life regarding accessibility.  From the crosswalks we use to providing Braille on our business cards.  Accessibility is here and becoming more important for the web.  
Make a PDF accessible
One of the characteristics of an accessible PDF is a logical document structure indicated by tags. 
Tags in a PDF
The tags indicate the structural elements of a document – such as which page elements are title, headings, figures, text, tables, and so on – and how these elements relate to each other. These tags are similar to the paragraph styles, HTML tags, or XML tags you might use in non-PDF documents.  
Think of your audience when developing a tagged PDF

It is always best practice to know and understand what kinds of issues people with disabilities might encounter when reading PDF files.  Usually, when we think of a tagged PDF in Acrobat, we are most likely focused on the accessibility of our documents to screen readers.  It is very important to remember not everyone viewing our documents may be blind; there are also many different types of disabilities to consider.

Motor disabilities

We need to be careful and thoughtful of the size of our font size in our documents. Links in a document shouldn’t be too small that someone with limited fine muscle control will have a difficult time trying to click the link.

Hearing disabilities

Not only a must for HTML, transcripts should be provided if multimedia is being used. If your document has embedded multimedia objects involving sound, you will exclude both the deaf and deaf-blind if a transcript is not provided.

Cognitive disabilities

Simplicity is the theme.  Try to avoid using vocabulary most audiences will not be familiar with.  If possible, try to bookmark and combine PDFs rather than linking to external files and creating more pop-up windows.  Try your best to make your documents easy to understand and interpret.

Low vision

Ensure your documents have enough contrast.  Do not use bright colors with bright backgrounds.  If there is information conveyed with color, be sure the same information is conveyed if color is not available.  Adding a textual cue may assist in conveying the information just the same as color.  

Approaching accessibility

One important thing to remember is that not all files that are in PDF format actually need to be a PDF.  Users should consider if it may be easier to develop a web page rather than creating a PDF.   

Methods for creating PDF documents

PDF documents can be created from multiple sources.  Each source can have its own impact how a document can be made accessible.  
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UNDERSTANDING TAGS IN A PDF
PDF tags can be considered the skeleton of a PDF document.  They hold the document together providing a logical structure and reading order.  They are a text-only representation of the PDF file and only serve a purpose for accessibility purposes and have no visible effect on the PDF itself.  Without the proper tags in place, the document is no longer in a logical structure and then becomes inaccessible.  
PDF tags can also be compared to HTML tags.  HTML tags are used to build web pages and are almost identical to PDF tags, but are still very different.  It is true that if you are comfortable working with HTML that you will probably have an easier time creating and editing tagged PDF documents. 

How assistive technologies interpret tags

Assistive technologies such as screen readers interpret tags by letting the user know immediately what type of document they are viewing.  They identify all types of headings, paragraphs, tables, forms, etc… 
To better understand how important it is to use the proper tags when needed, screen readers will announce how many headings there are in the document that will allow users to skip to each heading without having to read an entire section.  Therefore, making the document more usable which usability is also a major factor to consider when making PDFs accessible.  
Screen Readers

Screen readers are used to read a document out loud to a user from the tag structure.  A good way of thinking how to make your document accessible is to visualize how you wish your document to be read to you.  

Job Access with Speech (JAWS) and Window-Eyes are two of the most popular screen reading technologies out-to-date.   Both have many different functions and features, but both read from the tag structure. 

Most frequently used PDF tags

The table on the next page describes some of the most common tag elements used in Adobe Acrobat.  Majority of these tags can be found from the “TouchUp Reading Order” tool which we will review in detail later.  

COMMON TAGS AND THEIR ASSOCIATIONS
	PAGE ELEMENT
	PDF TAG
	PURPOSE OF THE PDF TAG

	Heading 1         
	<H1>
	The primary heading or title of the document

	Heading 2               
	<H2>
	Section or chapter headings

	Heading 3                         
	<H3>
	Subsections headings

	The body of text is normally associated with a paragraph tag.  Paragraph tags use the <P> tag, which are very similar to HTML paragraph tags.  If the “TouchUp Reading Order Tool” palette is open, identify paragraphs of text by clicking the “text” button on the palette.

	<P>
	Paragraphs of text

	· List item 1

· List item 2

· List item 3

· List item 4

· List item 5


	<L>

<LI>

<LBL>

<LBody>
	· <L> Main tag container

· <LI> For each List Item

· <LBL> Represents the bullet

· <LBody> “List Item 1”, etc.
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	<Figure>
	Used for each image located within the document.

If image is a graphic representation to page, Alternate Text must be added. Otherwise, marking the figure as background is acceptable.  


	url  (url) 

http://ca.gov
	<Link>

LINK - OBJR
	<LINK> tag represents a link is present in the document

Within the <LINK> tag should have the element with the URL:

Within the <LINK> tag should have the LINK – OBJR element.  Inserted automatically when tags are added from Adobe Acrobat or generated from source application.



	Name:  ________________
Yes [ ]     No [ ]

	<Form>
	Each form field will need a <FORM> tag to represent it’s a form field.
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DIFFERENT METHODS FOR CREATING PDF DOCUMENTS

The three most common methods for creating PDF documents:

1. File > Print method

2. Convert to PDF method from a native application like MS Word, or any MS Office or Adobe product.

3. Scanned file method.
Advantages and disadvantages for each method

Creating a PDF using any method is entirely user-based.  There are advantages and disadvantages for each method and it’s up to you to decide which method works best for your particular type of document.
Print versus convert versus scanned
It is very important to remember that using the print option from the file menu to create a PDF is exactly what it is.  You are printing your document exactly the same way as if you were printing a hard copy, but a PDF is the output.  

Converting your document to PDF is exactly how it sounds.  You are converting your document from one format to PDF format.

Scanned files are only useful when an electronic source version is not available.  Type of scanner, scanning resolution and quality of hard copy all play a factor when creating a PDF and the desirable output.  
Review the following table to determine which method best meets your needs.

	METHOD
	ADVANTAGE
	DISADVANTAGE

	FILE > PRINT
	· clean document to start with

· file size is smaller
· no extra hidden code
	· tags will have to be added manually

	CONVERT TO PDF 
	· tags are added automatically
· bookmarks can also be added automatically
	· file size larger
· tags are based from native application than Acrobat’s version

· extra hidden code is revealed in tag structure
· improper use of native application results in more work in Acrobat

	SCANNED
	· use if electronic source version is unavailable
	· OCR process needed before tags can be added
· file size extremely large

· quality of hard copy determines quality of PDF


TOOLS FOR THE JOB
To make a PDF accessible, users need to know and understand the tools that will assist them.  The accessibility tools are only used for tagging PDFs.  They are not needed for other types of tasks.  
“TouchUp Reading Order”
The “TouchUp Reading Order” tool (see Setting up your workspace) is one of the main tools used for creating accessible PDFs.  This tool has the capability of correcting/editing a majority of your documents’ tags and structure.  There are some detailed tags that the “TouchUp Reading Order” tool cannot produce; therefore, those types of details need to be created manually from the Tags Panel (see Working in the Tags Panel). 
TouchUp Reading Order tool buttons
Text – Tags the selection as text.

Figure – Tags the selection as a figure. Text contained within a figure tag is defined as part of the image and is not read by screen readers.

Form Field – Tags the selection as a form field. 
Figure/Caption – Tags a selected figure and caption as a single tag. Any text contained in the tag is defined as a caption. Useful for tagging photos and captions and preventing caption text from being incorrectly added to adjacent text blocks. Figures may require alternative text.

Heading 1, Heading 2, Heading 3 – Tags the selection as a first, second, or third level heading tag. You can convert heading tags to bookmarks to help users navigate the document.

Table – Tags the selection as a table after the selection is analyzed to determine the location of headings, columns, and rows.

Cell – Tags the selection as a table or header cell. Use this option to merge cells that are incorrectly split.
Formula – Tags the selection as a formula. Because speech software may handle formula tags differently from normal text, you may want to add a description using alternative text.


Background – Tags the selection as a background element, or artifact, removing the item from the tag tree so that it doesn’t appear in the reflowed document and isn’t read by screen readers.

Table Inspector – Automatically analyzes the selected table into cells and applies the appropriate tags. The table must be tagged as a table before you can use the Table Inspector command on it.

Show Page Content Order – Shows content elements as highlighted areas that contain numbers to indicate the reading order. Specify the highlight color by clicking the color swatch.

Show Table Cells – Highlights the content of individual table cells. Specify the highlight color by clicking the color swatch.

Show Tables And Figures – Outlines each table and figure with a crossed-out box. The box also indicates whether the element includes alternative text. Specify the box color by clicking the color swatch.

Clear Page Structure – Removes the tagging structure from the page. Use this option to start over and create a new structure if the existing structure has too many problems. 

Show Order Panel – Opens the Order tab to allow you to reorder highlighted content.

OTHER FEATURES PROVIDED BY THE “TOUCHUP READING ORDER” TOOL
Edit Alternate Text – Available in the menu that appears when you right-click a highlighted figure. Allows the user to add or edit a text description to the figure properties that is read by a screen reader or other assistive technology.

Edit Form Field Text – Available in the menu that appears when you right-click a form field. Allows the user to add or edit a form field text description that is read by a screen reader or other assistive technology.

Edit Table Summary – Available in the menu that appears when you right-click a highlighted table. Allows the user to add or edit a text description to the table properties that is read by a screen reader or other assistive technology.
“TouchUp Reading Order” Tool Tag Options

	Button
	Adobe Tag

	Text 
	<P>

	Form Field 
	<Form>

	Heading 1    
	<H1>

	Heading 2
	<H2>  

	Heading 3
	<H3>

	Figure 
	<Figure>

	Figure/Caption 
	<Figure>

	Table 


	<Table> 

<TR>
<TH> <TD>


	Cell 
	<TD>

	Formula 
	<Formula>

	Background 
	none


Viewing a document with the “TouchUp Reading Order” tool activated –
After you have added tags to your document.  When the TouchUp Reading Order tool is activated, the reading order structure appears. By default, Show page content order, Show table cells, and Show tables and figures are marked in the color black.  

You change the color to help break apart the order and page elements in a document.  This is useful when dealing with complex document structure.  You may also find it useful to periodically turn on/off each item while working with your documents.
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A. Show Page Content Order – The reading order sequence begins with “1” being the first priority to be read to the user.  Sequence numbers can vary, just understand that the highest number takes last priority to be read.

B. Show Table Cells – Highlights all table cells that are defined

C. Show Tables and Figures – Outlines and marks all figures and tables
Table Inspector
New to Acrobat 8 is the Table Inspector.  It can be accessed from the TouchUp Reading Order tool.  The Table Inspector allows users to define the proper table elements.  It can mark the appropriate table headers and table data cells.


Right-click on any cell to open up the “Table Cell Properties…” and “Table Inspector Options…” menu.
Table Inspector Option
Colors options can be changed as well to assist with color coding the table elements. 
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Table Cell Properties

You now have the option to identify the proper Table Header and Table Data Cell without necessarily working directly in the tag structure.  Extremely complex tables should be edited in the tags panel. 
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Selecting page elements to edit tags

There are a couple of selection methods for changing tags while the TouchUp Reading Order Tool is active.  

Marquee selection – When the mouse icon is set as the cross hair,  

click and drag a selection around the page element you wish to tag.
The selection is indicated by a border around the page element. 


Grab selection – When the mouse is hovering over the 
content order number, the icon will turn into an open hand. 
Left-click the content order number to select the page 

element. The hand will appear to be grabbing the number 

and the number then becomes selected. 

CREATING PDFS FROM VARIOUS OUTPUT SOURCES – FILE > PRINT METHOD
File > Print 
	1. Select File from the Menu Bar

2. Select Print from the drop down list
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3. Choose “Adobe PDF” from the printer “Name:” drop-down list.

(Note: Name option can vary depending on the application used to create the PDF)
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A “Save PDF File As” dialog box will appear and you can save your file as a PDF document. 


CREATING PDFS FROM VARIOUS OUTPUT SOURCES – CONVERT TO PDF METHOD
Convert to PDF method
	1.  Select the “Convert to Adobe PDF” button from the toolbar
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OR

1. Select “Adobe PDF” from the Menu Bar

2. Select “Convert to Adobe PDF” from the drop down list
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SETTING UP YOUR WORKSPACE
Be sure Acrobat and a PDF are open to set up your workspace.  Unfortunately, that is the only way that it can be done.
All toolbars and navigation panels can be accessed by the “view” option from the menu bar
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Toolbars and Navigation Panels are where we need to retrieve the following:
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Toolbars

· Advanced Editing Toolbar

· Page Navigation Toolbar

· Select & Zoom Toolbar
If you are opening the Advanced Editing Toolbar for the first time, the TouchUp Reading Order Tool may be missing. 

If so, open the Toolbars menu, at the bottom of the menu click “More Tools…”.
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With the More Tools dialog box open, check the “TouchUp Reading Order Tool” checkbox. 
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Navigation Panels

· Pages

· Bookmarks

· Tags

· Content 

· Order
Tags, Content and Order tabs should normally be grouped together. 
Click and drag each tab to dock it in the Navigation Panel.
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VIEWING AND UNDERSTANDING THE TOOLBARS
· Advanced Editing Toolbar

A. Selection Tool – Select objects for tagging, especially useful when working with forms.
B. Touch Up Text Tool – To fix minor errors prior to tagging documents.

C. TouchUp Reading Order Tool – The main tool used for correcting/editing tags.
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· Page Navigation Toolbar
A. Previous Page
B. Next Page
C. Page Jump – Manually enter page number to jump to specified page. 
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· Select & Zoom Toolbar

A. Select Text & Images – Selects text for copy-n-paste and click and drag selects images.
B. Hand – Page through document contents.
C. Marquee Zoom – Click and drag to zoom on a particular section.

D. Minus & Plus buttons – Increase magnification by increments.

E. Manual Zoom – Manually enter a zoom percentage or use pre-sets.
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VIEWING AND UNDERSTANDING THE NAVIGATION PANELS
Learning and understanding the Navigation Panels will give you a better understanding of how to use the Accessibility tools.  Try keeping your Tags Panel open while you use the TouchUp Reading Order Tool.  You can see how the tags change as you reclassify your regions.  

Navigation Panels Set up for Section 508 Tagging
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	A. Pages – Quick navigation through various pages. Pages can also help provide a structured tab order and document reading structure through it’s properties.

	
	B. Bookmarks – Increase usability and quick navigation for sections.  Although not required, it’s highly recommended that documents over 10 pages have bookmarks.  Bookmarks should be associated with Heading Level 1 elements.

	
	C. Tags – Accessibility purposes only, provide logical structure of   document.  Tags can be corrected/edited directly in the Tags Panel.  There are more advanced and detailed tags in the Tags Panel.  Screen readers read to the user(s) from the tag structure.  Note: If tag structure is manipulated manually, it will override the reading order created by the TouchUp Reading Order Tool or changed from the Order Panel. 

	
	D. Content – All elements within the document.  Content Panel can be used to delete specific items.  Normally for accessibility purposes, the content tab should rarely be opened.  Unless a particular element that needs to be deleted to fix the document reading structure.  Only Advanced Users should work in the content tab.  

	
	E. Order – Displays the reading order of the document. Drag-n-drop can be used to change the reading order. Reading order content is displayed the same as when the TouchUp Reading Order Tool is activated.  


SETTING UP YOUR DOCUMENT PROPERTIES
I recommend setting up your Document Properties first before tagging your document.  Document Properties tend to be overlooked after a document has been tagged and made accessible.   
If your accessible PDF is to be viewed and searched on the AG’s Internet or Intranet websites, it’s very important to set the Document Properties.
To view the Document Properties, go to File > Document Properties or hold down the ctrl key and press D on your keyboard for the keyboard shortcut(“ctrl”+”D”)
Description Tab

The search engine on the Internet and Intranet searches in a hierarchy structure:

1. Document Title – Use a meaningful title for the document
2. Document Author – Use  CA DOJ  and your program name

3. Document Subject  - Use a meaningful subject for the document
4. Document Keywords – Use appropriate keywords. We write our keywords in the following format: keyword followed by a comma then a space and next keyword (ex. keyword, keyword, keyword, etc…)
We also need to check whether the document has been tagged and that Fast Web View is yes.  It is okay to have Fast Web View to say no while we are making our document accessible and routinely saving it.  We just need to make sure that once our document is finalized that Fast Web View is yes.
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Initial View Tab
We need to set our Window Options show the Document Title instead of the Filename from the drop down list.

If your document has bookmarks, in the Layout and Magnification section, Bookmarks Panel and Page needs to be selected from the Navigation Tab drop down list .
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Advanced Tab

We need to set a reading language for the document to read to our user.  English Us will most likely be the main language of the document.  
If you are working on a document that does not have the language you need.  You can visit the Library of Congress website (http://www.loc.gov/standards/iso639-2/php/code_list.php) and manually type a code in the Language box to in the Reading Options section.   
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ADDING TAGS TO A PDF
Adobe Acrobat 8 allows users to create a tagged PDF document from untagged PDF files.  Tagged PDF documents can provide enhanced user accessibility depending on the document design as well as the capacity to save a PDF document into alternate formats (e.g., HTML, Accessible Text, RTF, etc.).  If creating electronic forms, it is necessary to use Adobe Acrobat Professional or Adobe LiveCyle Designer (PC-only) to create accessible PDF-based forms.

Adding tags manually to a PDF document does have some limitations.  While Acrobat can automatically add tags to a PDF document, there is no guarantee that the document content will be tagged in the correct reading order.  Documents that contain regions of high complexity, such as rich visual layouts, may result in a tagged structure that does not follow the logical reading order of the original document.  Any graphics or charts in the PDF document may not be processed correctly and may be rendered as “Figures” or “Inline Shapes”.  It is necessary to identify these items and add the appropriate alternative text descriptions.

Adobe Acrobat 8 includes the “TouchUp Reading Order Tool” that allows an author to specify a logical reading order of the PDF document as well as simplify the process of adding image descriptions.  The TouchUp Reading Order tool also includes a Table Inspector to improve the accessibility of data tables within PDF​ documents.
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Adding Tags 

Open the PDF document that does not contain the tagged structure.

Select Advanced > Accessibility > Add Tags to Document.  This will start the tagging process of the PDF document.  After the program fin​ishes processing the document, use Save As and save the file with a new name.

WORKING IN THE TAGS PANEL
The Tags Panel provides the user with the ability to view the underlying struc​ture of the PDF document.  With the Tags Panel, the PDF document creator can manipulate the structure of the document as well as the informational content contained within the various tag levels.  For example, a PDF document author can insert text descriptions, reclassify headings, etc. for various elements after creat​ing the PDF document.
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It may be difficult to locate the specific tag for a given image (or text block) when working in a document.  It may be easier to locate content and the respective tag by enabling the “Highlight Content” feature in the Tags Panel.  The Highlight Content feature is available from the “Option” menu in the Tags Panel or by per​forming a right-mouse button click on a tag.

WORKING WITH FORMS
It is very important to not use keyboard characters to visually format the form fields (e.g., creating lines for signatures using the “underscore” character, etc.).  Rather, use Adobe Acrobat Professional or the Adobe LiveCycle Designer tool to create these visual references when constructing PDF forms.

You must first create a tagged PDF document before adding the necessary form tags. 

1. Turn on the Tags tab.  Under the “Options” menu in the Tags Palette, enable “Highlight Content” and “Tag Annotations”.

2. Choose the content in the tag structure that immediately precedes where the form field will be located.  For instance, if you are going to enter a form field after the “First Name:” text, then it is necessary to select the tag with the correct text.

3. Select the appropriate form tool from the formatting bar.

4. Create a form field of the desired size by clicking the mouse button and dragging the crosshairs to the correct dimensions.  When you create this form field, the necessary form tags will automatically be placed into the correct location in the tags palette.

5. Enter a unique form field name in the “Name” text field in the Field Properties dialog box.

6. Enter supporting information in the “Tool Tip” text field.  The informa​tion provided in the “Tool Tip” text field can be accessed by assistive computer technology to prompt the user to enter the correct information.

7. Under the “Appearance” tab, choose the options you desire for your form field.  Under the “Line Style” option, you may select “Underlined” to visually represent a line for information.

UNDERSTANDING THE OCR PROCESS
Optical Character Recognition (OCR) enables you to search, correct, and copy the text in a scanned PDF.  It is a process that is needed before you can tag your document for accessibility. 
Primary OCR Language - Specifies the language for the OCR engine to use to identify the characters.
PDF Output Style - Determines the type of PDF to be produced. All options require an input resolution of 72 ppi or higher (recommended). All formats apply OCR and font and page recognition to the text images and convert them to normal text.

Searchable Image - Ensures that text is searchable and selectable. This option keeps the original image, deskews it as needed, and places an invisible text layer over it. The selection for Downsample Images in this same dialog box determines whether or not the image will be downsampled and to what extent.
Searchable Image (Exact) - Ensures that text is searchable and selectable. This option keeps the original image and places an invisible text layer over it. Recommended for cases requiring maximum fidelity to the original image.
Formatted Text & Graphics - Reconstructs the original page using recognized text, fonts, and graphic elements. The accuracy of the results depend on the scanning resolution and other factors. You may need to review and correct the OCR text in the new PDF page after scanning.
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Black-and-white scanning at 300 ppi produces the best text for conversion. At 150 ppi, OCR accuracy is slightly lower, and more font-recognition errors occur. For text printed on colored paper, try increasing the brightness and contrast by about 10%. If your scanner has color-filtering capability, consider using a filter or lamp that drops out the background color.
CHECKING YOUR DOCUMENT FOR ACCESSIBILITY
The 100% guarantee and only true test to see whether your document is accessible or not; is to review it using an Assistive Technology device such as a screen reader.  The JAWS screen reader is considered one of the most popular screen reading software applications to date.  Unfortunately, it’s a little bit on the pricey side and most users won’t have access to it.  There are more screen reader applications available as well.    
There are other methods to check your document for accessibility, but it’s very important not to fully rely on these methods.  There are flaws with these methods and they are not entirely accurate.  But 99% of the time will give you the same effect as listening to your document from a screen reader.
Acrobat Full Check 
The Acrobat full check is available with Acrobat.  It’s very good accessibility checker for finding errors in your document.  But keep in mind that just because you can get your full check to report no problems found, doesn’t necessarily mean that your document is accessible.  

The full check does not check tag and structure order.  If your tag structure is different than how the document appears, it will pass the full check, but will not be accessible because your document is not being read in a correct order.  

Here is brief list of the most common full check error results that I have encountered:
1. Document Lacks a language specification

2. Text Blocks lack a language specification (same as above, error normally shown when a document has been through an ocr process)
3. No alt text for figures

4. No form field descriptions (tool tips, same as providing alt text for figures)
Acrobat also has a strange way of the displaying the same type of error in different context.  It will take a lot practice and various documents to get familiar with this type of situation.
Perform a Full Check

To perform a full check, go to Advanced > Accessibility > Full Check
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When the Accessibility Full Check dialog box appears.  Leave everything at it’s default and click the “Start Checking” button at the bottom of the box.  
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After the document has been checked for any errors, a message box will appear either stating all of the errors Acrobat found, or if Acrobat did not find any errors.  
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Click the OK button and the Accessibility Report will appear in your Navigation Panel.  
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There are links in the Accessibility Report that will provide you with the location of the error and tips on how to fix it with the accessibility tools.  

Save as Text Accessible

This method is almost 100% identical to how a screen reader will interpret your document but in a text version.  One thing to note is that it doesn’t handle multi-column layouts very well and there are a few other flaws with this testing method.  But it is generally very accurate.

When you save your document as text accessible, you are taking your document and creating a text version of it.  
When you combine the Full Check with saving as text accessible, you can find the tag and structure errors that the full check does not find when you view your document in it’s text format.  

The text format is created based on your tag structure.  Just be aware that multi-column pages may present problems when viewing.  So you have to rely on your tag structure to be in the correct order since screen readers read from the tags.

To save your document as Text Accessible

Go to File > Save as
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When the Save As dialog box appears. 
1. Give your document the proper name and location of where to save the file.  

2. Click the Save as type drop-down list and choose Text (Accessible)(*.txt)
3. Click the Save button.
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A couple of items to recognize while viewing the text version of your document:

1. Tags will not appear in the text accessible file.

2. Tool tips are displayed with parentheses.

OPTIMIZING YOUR PDF FOR FAST WEB VIEW
Optimizing a PDF is like applying the final touch to it before it’s ready to be sent out or posted via web.   What optimizing does it finds a way to take your document and make it the smallest possible file size without lowering the quality.  

There are various techniques described in Acrobat’s help menu that are based on user preferences when optimizing.  Refer to the Acrobat manual to find what type of optimization your PDF will need to suit your needs.  
As far as accessibility goes, we merely want our document to have a fast web view of “Yes” and be compatible with an Acrobat reader of “5.0 or later”. 

You will be able to tell that your document has been optimized when you view your document properties and the “Fast Web View” displays “Yes”.  Also from the document properties, you can find out what version the document has been saved for.  

Optimizing should be last because it can start to lower the quality of the document if it has been optimized over and over again.

Optimize your PDF

To optimize your PDF, go to Advanced > PDF Optimizer…
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When the PDF Optimizer dialog appears 

1. Choose Acrobat 5.0 or later under the Make Compatible with drop-down list.

2. Adjust any of Image Settings if necessary

3. Click OK
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You will be prompted to save your file again.  It is safe to overwrite the old file with the new one.  
Here are a couple of items to note about optimizing:

1. File sizes decrease with a minimal loss of quality

2. Not all users have the latest version of Acrobat, choosing 5.0 is a safe version to save for. (Forms built in Life Cycle Designer can only be reverted back to 6.0 and later.)

3. Optimizing is recommended only 1 time.  Multiple times can lower quality.

Adobe’s additional instructions and information can be found in their documents -
Getting Started http://help.adobe.com/en_US/Acrobat/8.0/Professional/gs.pdf  32 pages and
User Guide http://help.adobe.com/en_US/Acrobat/8.0/Professional/help.pdf  585 pages, Chapter 10: Accessibility.
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